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2  
Conceitos fundamentais 

 
 
Apresentam-se alguns conceitos fundamentais na utilização do AutoCAD, 
como a área gráfica, sistemas de coordenadas, funções auxiliares, comandos 
mais importantes para o desenho 2D e conceitos sobre a impressão. 
 
 
2.1. Iniciação e área gráfica 
 
Um desenho em CAD é um ficheiro, ou um conjunto de ficheiros, 
que contém a informação sobre todos os segmentos de reta, arcos, 
texto, cotas, etc. No AutoCAD, os desenhos têm, principalmente, a 
extensão DWG. Os ficheiros DXF são usados para comunicação com 
outros programas e os ficheiros DWT são ficheiros protótipo (base 
para novos desenhos).  
 
Apresenta-se a área gráfica Drafting and Annotation, por omissão do 
AutoCAD, versão 2009 e seguintes: 
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Auxiliares gráficos 
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ISODRAFT Linha Status:  
Não está no ribbon 

Não está em menus 

LT 
15 

Permite ativar o modo isométrico e escolher qual o plano. 
Orthographic – Regressa ao modo ortográfico. 
isoplane Left – Ativa o plano esquerdo. 
isoplane Top – Ativa o plano de topo. 
isoplane Right – Ativa o plano direito. 
Nota: Embora faça o mesmo, é preferível ao ISOPLANE. 

 
SNAPSTYL Inteiro Desenho 0 
LT 
00 

Especifica o estilo para a janela ativa. 
0 – estilo normal; 1 – estilo isométrico. 

 
SNAPISOPAIR Inteiro Desenho 0 
LT 
00 

Controla o plano isométrico ativo. 
0 – plano esquerdo; 1 – plano de topo; 2 – plano direito. 

 
'OSNAP, OS B: Object Snap:  

Não está no ribbon 

Tools>Drafting Settings 

LT Mostra o separador Object Snap do comando DSETTINGS. 
00 A tecla F3 (ou através da linha Status) ativa ou desativa o 

acesso automático a pontos precisos. Se não houver pontos 
definidos, executa este comando. 

 
Tipos de pontos precisos (osnaps) 

Ícone Ponto Preciso Descrição Imagem 

 FROm Derivação de ponto a partir 
de um ponto conhecido por 
coordenadas relativas.  

 Temporary 
Tracking 
(TT) 

Marcação de ponto auxiliar 
para derivação de ponto. 
Após adquirir um ponto 
preciso (pausa), digita-se TT 
e marca-se o ponto tempo-
rário.  



Configurações da área gráfica e do desenho 
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 Separador System – Permite o controlo de parâmetros do 
sistema. Em Hardware Acceleration acede-se a uma caixa para 
controlar o desempenho e a degradação visual na 
representação dos modelos 3D e a opção permite atualizar 
certificações de placas gráficas. Na área Current Pointing 
Device escolhe-se o elemento de entrada (rato ou mesa 
digitalizadora). Touch Experience indica se o painel de 
controlo de visualização em dispositivos de ecrã tátil é 
mostrado no ribbon. Layout Regen Options controla o 
processo de regeneração quando se muda de espaço (modelo 
ou composição). Em General Options incluem-se diversas 
opções de sistema: controlo das caixas de aviso em Hidden 
Messages Settings, visualização ou não da caixa de 
propriedades OLE, aviso sonoro de erros e possibilidade de 
utilização de nomes grandes para definições. Desligando a 
opção de Help, opta-se pelo Help offline (cuja instalação é feita 
fora doAutoCAD). Através do botão em InfoCenter pode 
controlar-se a colocação e propriedades dos balões com 
mensagens de atualizações e de informação facultativa. 
Security inclui um botão que mostra uma caixa para o controlo 
da segurança de aplicações a carregar. Através de dbConnect 
Options existem duas opções para guardar as ligações no 
desenho e para abrir as tabelas em modo protegido.  

 



Desenho 
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MTEXT, T B: Draw, Text:  
R: Annotate>Text 

Draw>Text> 
Multiline Text 

LT 
00 
15 

Cria texto multilinha. Dentro de um 
único texto, pode haver caracte-
rísticas distintas. Define-se a caixa 
envolvente (largura) do texto através 
de dois cantos opostos. Aparece uma 
régua para a colocação de indentações 
e tabs e, eventualmente, duas barras.  

 

 

Tipo de 
let ra 

Altura 
de texto 

Bold/ itálico/corta/su blinha/sobrel inha 

Símbolo Tracking 
Width factor Oblique 

Menu Cor 
Esti lo 
ativo 

Opções de 
jus tificação 

Listas Field 
Colunas Just ificação 

Parágrafo 

Frações 

Afastamento entre 
linhas 

 

 
 O texto escrito assume as propriedades ativas. Selecionando 

texto, podemos alterar as suas propriedades. Menu de 
contexto: 
Select All – Seleciona todo o texto. 
Cut/Copy/Paste – Corta, copia e cola o texto selecionado. 
Permite inserir texto exterior. 
Paste Special – Colar sem formatações. 
Insert Field – Mostra a caixa para inserção de campos de texto 
(ver ponto seguinte). Com um campo selecionado, existem 
opções adicionais: Edit Field para o editar, Update Field para 
o atualizar e Convert Field to Text para o converter para texto. 
Symbol – Permite a inserção de símbolos. 
Import Text – Permite importar um ficheiro texto ou RTF. 
Paragraph Alignment – Escolha da justificação para o texto. 
Paragraph – Caixa para a definição de parágrafos, com 
indentações e tabulações. 
Bullets and Lists – Permite criar listas numeradas, com letras 
ou não numeradas, iniciar ou continuar a numeração. 
Columns – Definição de colunas e respetivas propriedades. 



Construção 
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OFFSET, O B: Modify:  
R: Home>Modify 

Modify 

LT 
00 
13 

Cria entidades paralelas à entidade a indicar. O comando 
começa por pedir a distância à entidade original (offset 
distance) ou a opção Through. Dando uma distância, é pedida 
a entidade original e para que lado fica a nova entidade. Dando 
T, é pedida a entidade original e um ponto onde vai passar a 
nova entidade. Em ambos os casos, é efetuada uma previsão (a 
partir da versão 2013) e estes pedidos são repetidos. 

 Undo – Anula o último offset. 
Multiple – Coloca o offset em modo 
múltiplo, repetindo a distância (ou 
Through) para o último objeto sele-
cionado. 
Erase – Apaga o objeto original, após 
ter sido criado o objeto paralelo. 
Layer – Permite escolher a layer do 
objeto paralelo entre a layer ativa ou a 
layer do objeto original.  

 
OFFSETGAPTYPE Inteiro Programa 0 
LT 
00 

Quando se aplica o OFFSET a 
polilinhas, controla como ficam os 
cantos nas novas polilinhas. 
0 – os elementos são prolongados 
para fechar os cantos; 1 – o canto é 
fechado com um elemento arco com o 
raio igual à distância de offset.  

 2 – o canto é fechado com um chanfro com uma distância  
perpendicular igual ao valor de offset. 

 
OFFSETDIST Real    Não gravado 1 
LT 
00 

Conserva a distância para a criação de entidades paralelas. 
< 0 – as entidades paralelas vão passar sobre pontos a marcar 
(opção Through); > 0 – distância das entidades paralelas. 

 



Blocos dinâmicos 
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ATTREDEF Não tem ícone 
Não está no ribbon 

Não está em menus 

00 Redefine um bloco com atributos. Pede o nome do bloco a 
redefinir, a seleção de objetos e o ponto de inserção, que 
passam a definir o novo bloco. Para inserções já efetuadas 
deste bloco, os valores dos atributos que continuam no bloco 
mantêm-se; novos atributos ficam com os valores omissos e os 
valores de atributos que deixam o bloco desaparecem. 

 
 
10.3. Blocos dinâmicos 
 
BEDIT, BE B: Standard:  

R: Home>Block 

Tools>Block 
Editor 

LT 
06 
10 

Abre o editor de blocos para o bloco a criar ou a editar. Mostra 
a caixa Edit Block Definition para a escolha do bloco a editar 
ou, digitando um nome, para criar um bloco. Aparece o editor 
de blocos, onde podemos editar o bloco selecionado e usar os 
comandos AutoCAD para a criação de um bloco. A principal 
função do comando é a atribuição de comportamentos 
dinâmicos a blocos, através da adição de parâmetros (grips 
azuis) e de ações sobre esses parâmetros (faíscas amarelas).  
Temos comandos específicos para o editor de blocos, 
apresentados a seguir. Alguns são acedidos pela barra de 
menus (ou separadores contextuais do ribbon) e também pelas 
paletas Block Authoring Palettes. 
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11  
Cotagem 

 
 
Apresentam-se todos os comandos e variáveis de cotagem do AutoCAD. 
Optou-se por apresentar no ponto 11.3 todas as variáveis de cotagem em 
conjunto, dado que a grande maioria interfere com todos os tipos de cotas. 
 
 

11.1. Criação de cotas 
 
DIM Não está em barras 

R: Home>Annotat.  
Dimension> 

Linear 
LT 
16 

Cria, com um único comando, diferentes tipos de cotas com 
base nos pontos marcados ou entidades selecionadas. Por 
omissão, pede a seleção de um objeto ou a indicação da origem 
da primeira linha de chamada e mostra a cota mais adequada. 
Deslocando o rato ou com as opções, pode escolher-se outro 
tipo de cota. O pedido é repetido até cancelamento. 

 
Tipo de cotas por omissão com a seleção de objetos: 
Arco e circunferência: cota de raio; segmento: cota linear; 
cota: divide cota em duas, pedindo a origem da primeira linha 
de chamada. 
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12  
Tramas 

 
 
Incluem-se, neste capítulo, os comandos e variáveis para aplicação de tramas 
ou tracejados (padrões regulares que preenchem áreas). No apêndice 3 
apresentam-se todos os padrões que vêm com o AutoCAD. 
 
 
12.1. Aplicação de tramas ou tracejados 
 
HATCH, H B: Draw:  

R: Home>Draw 

Draw>Hatch 

LT 
00 
11 

Preenche uma área com um padrão 
regular, uma cor sólida ou um gradiente 
de cores. Mostra uma caixa de diálogo 
com dois separadores e vários botões, 
onde se indicam as características do 
padrão e as áreas de aplicação. 

 

 

 



Utilitários 
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AUDITCTL Inteiro Programa 0 
LT 
00 

Especifica se o comando AUDIT cria um ficheiro relatório 
com a extensão ADT. 
0 – não escreve o ficheiro; 1 – escreve o ficheiro. 

 
TASKBAR Não tem ícone 

Não está no ribbon 
Não está em menus 

LT 
05 
12 

Indica se os desenhos aparecem em separado na barra de 
tarefas do Windows. Admite dois valores: 
0 –  Apenas aparece uma tarefa AutoCAD; <CTRL+TAB> faz 

o ciclo entre os desenhos. 
1 –  Cada desenho aberto é mostrado na barra de tarefas, 

permitindo fazer o ciclo com <ALT+TAB>. Este é o modo 
por omissão no Windows 7. 

 
DOWNLOAD-
MANAGER 

Não tem ícone 
Não está no ribbon 

Não está em menus 

12 Mostra o estado do descarregamento atual de ficheiros. Na 
versão 2012 apenas se aplica à biblioteca de materiais 
Autodesk Medium Image Library. 

 
'SCALELISTEDIT Não tem ícone 

R: Annotate>Annotation 
Format> 
Scale List 

LT 
06 
11 

Controla as escalas mostradas nas 
listas dos comandos  PAGESETUP e 
PLOT, nas propriedades de vistas 
(viewports) e anotativas. Permite 
adicionar, editar, ordenar e apagar 
escalas. Reset coloca todas as escalas 
predefinidas no AutoCAD, 
eliminando as escalas do utilizador.  

 Notas: A partir da versão 2008, as escalas ficam gravadas com 
o desenho e não com o programa. A partir da versão 2011, o 
botão Reset permite colocar as escalas gravadas com o programa, 
conforme definidas no comando OPTIONS. 
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A4 Apêndice 4 – 
Tipos de ficheiros usados 

 
 
Apresentam-se, por ordem alfabética, todos os tipos de ficheiros usados 
pelo AutoCAD. Inclui-se, para cada tipo, uma breve descrição. 
 
 
A4.1. Tipos de ficheiros 
 
.$$$ AutoCAD Emergency Backup Drawing. 
.$A Ficheiro temporário AutoCAD. 
.3DM Ficheiro Rhino. 
.3DS  Modelos 3D Studio versões 4 e anteriores. 
.AC$ Ficheiros temporários criados pelo AutoCAD e mantidos enquanto 

em edição. 
.ACB Livros de cores (Autodesk Color Book). 
.ACTM Ficheiro de macro (Action Macro). 
.ADSKLIB  Biblioteca de materiais. 
.ADT Relatórios de AUDIT (se AUDITCTL tem o valor 1). 
.AHP Ficheiros de ajuda do AutoCAD. 
.ARG Ficheiro com informação de perfil de utilizador (profile). 
.ARX Aplicações ARX (linguagem de desenvolvimento). 
.ASM Ficheiros com código-fonte ADS. 
.ATC Catálogo de ferramentas Autodesk. 
.AVI Formato de animações. 
.AWS Ficheiro de perfil onde são gravados os grupos de toolpalettes. 
.BAK Ficheiros de reserva (backup) de desenhos DWG. Conserva a 

penúltima versão. 
.BAS Ficheiros Microsoft Visual Basic. 
.BAT Sequências de comandos DOS (Batch files). 
.BCL Ficheiro batch de desenho para a aplicação TrueConvert. 
.BDF Fontes VESA. 
.BKn Ficheiros de reserva de emergência, numerados sequencialmente 

com n a começar em 1. Se o AutoCAD termina inesperadamente, 
tenta gravar o desenho atual, mas para o caso de o desenho estar 
corrompido, o ficheiro BAK existente fica com a extensão BKn. 
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